Swordfish III User Guide

Copyright © 2007 - 2016 Maxprograms
# Table of Contents

**Introduction** ................................................................................................................................. 1  
  Swordfish Translation Editor ............................................................................................................. 1  
  Supported File Formats .................................................................................................................... 1  
  Supported Platforms ......................................................................................................................... 2  
  Features ........................................................................................................................................ 2  
  Supported Standards ....................................................................................................................... 3  
    XLIFF ........................................................................................................................................ 3  
    TMX ........................................................................................................................................ 3  
    SRX ........................................................................................................................................ 3  
    GlossML ................................................................................................................................. 4  
    TBX ........................................................................................................................................ 4  
**User Interface** .................................................................................................................................. 5  
  Standard Layout ............................................................................................................................ 5  
  Top-Down Layout .......................................................................................................................... 5  
  File Filtering View ....................................................................................................................... 6  
  Bookmarks View ............................................................................................................................ 6  
  Menus .......................................................................................................................................... 7  
    File Menu .............................................................................................................................. 7  
    Edit Menu ............................................................................................................................. 7  
    View Menu ........................................................................................................................... 8  
    Go To Menu .......................................................................................................................... 9  
    Options Menu ....................................................................................................................... 10  
    Tasks Menu .......................................................................................................................... 11  
    Terminology Menu .............................................................................................................. 13  
    Database Menu ..................................................................................................................... 13  
    QA Menu .............................................................................................................................. 14  
    Plugins Menu ....................................................................................................................... 14  
    Help Menu ........................................................................................................................... 14  
**Getting Started** .............................................................................................................................. 15  
  Translation Workflow .................................................................................................................. 15  
    Convert Files to XLIFF Format ............................................................................................... 15  
    Translating XLIFF Files .......................................................................................................... 16  
    Convert XLIFF File to Original Format .................................................................................. 17  
  Useful Options ............................................................................................................................ 18  
    Concordance Search .............................................................................................................. 18  
  Segment Filtering ....................................................................................................................... 20  
**Database Management** .................................................................................................................. 22  
  Supported Databases ................................................................................................................... 22  
  Create Database ......................................................................................................................... 22  
  Select TM Databases .................................................................................................................. 23
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import GlossML File</td>
<td>30</td>
</tr>
<tr>
<td>Import TMX File</td>
<td>27</td>
</tr>
<tr>
<td>Import CSV File</td>
<td>28</td>
</tr>
<tr>
<td>Import TBX File</td>
<td>30</td>
</tr>
<tr>
<td>Terminology Management</td>
<td>31</td>
</tr>
<tr>
<td>Select Terminator Databases</td>
<td>31</td>
</tr>
<tr>
<td>Add Term To Database</td>
<td>31</td>
</tr>
<tr>
<td>Add Selection to Database</td>
<td>32</td>
</tr>
<tr>
<td>Search Terms on the Web</td>
<td>32</td>
</tr>
<tr>
<td>Web Sites Configuration</td>
<td>32</td>
</tr>
<tr>
<td>Add Web Site</td>
<td>33</td>
</tr>
<tr>
<td>Edit Web Site</td>
<td>34</td>
</tr>
<tr>
<td>Remove Web Site</td>
<td>34</td>
</tr>
<tr>
<td>License Management</td>
<td>35</td>
</tr>
<tr>
<td>License Keys</td>
<td>35</td>
</tr>
<tr>
<td>Request an Evaluation License</td>
<td>35</td>
</tr>
<tr>
<td>Register a License Key</td>
<td>36</td>
</tr>
<tr>
<td>Disable a License Key</td>
<td>37</td>
</tr>
<tr>
<td>Transfer a License Key</td>
<td>38</td>
</tr>
<tr>
<td>Quality Assurance</td>
<td>39</td>
</tr>
<tr>
<td>Quality Assurance Options</td>
<td>39</td>
</tr>
<tr>
<td>Translation Preview</td>
<td>39</td>
</tr>
<tr>
<td>Translation Status Analysis</td>
<td>40</td>
</tr>
<tr>
<td>Translation Status History</td>
<td>40</td>
</tr>
<tr>
<td>Tag Analysis</td>
<td>41</td>
</tr>
<tr>
<td>Terminology Consistency Analysis</td>
<td>41</td>
</tr>
<tr>
<td>Leading/Trailing Spaces Analysis</td>
<td>42</td>
</tr>
<tr>
<td>Spell Check Segment</td>
<td>43</td>
</tr>
<tr>
<td>Spell Check Document</td>
<td>43</td>
</tr>
<tr>
<td>TTX Exchange</td>
<td>45</td>
</tr>
<tr>
<td>TTX Exchange Workflow</td>
<td>45</td>
</tr>
<tr>
<td>Export XLIFF File as TTX</td>
<td>45</td>
</tr>
<tr>
<td>Import Translations from TTX</td>
<td>45</td>
</tr>
<tr>
<td>Machine Translation</td>
<td>46</td>
</tr>
<tr>
<td>Machine Translation Engines</td>
<td>46</td>
</tr>
<tr>
<td>Configure Machine Translation Engines</td>
<td>47</td>
</tr>
<tr>
<td>Translate Segment with MT</td>
<td>48</td>
</tr>
<tr>
<td>XSL Transformation</td>
<td>49</td>
</tr>
<tr>
<td>Applying XSL Transformations</td>
<td>49</td>
</tr>
</tbody>
</table>
Swordfish III User Guide

Configuration Options .................................................................................................................................. 50
  User Interface ........................................................................................................................................ 50
  Font Settings ......................................................................................................................................... 50
  Shortcuts Configuration ......................................................................................................................... 50
  Color Settings ....................................................................................................................................... 51
XML Filter Configuration .......................................................................................................................... 51
  XML Catalog ......................................................................................................................................... 52
    Add Catalog Entry ............................................................................................................................... 52
    Edit Catalog Entry ............................................................................................................................... 54
    Delete Catalog Entry ........................................................................................................................... 55
XML Converter ........................................................................................................................................ 55
    Add XML Configuration ..................................................................................................................... 56
    Analyze XML Sample ......................................................................................................................... 58
    Edit XML Configuration .................................................................................................................... 58
    Delete XML Configuration .................................................................................................................. 59
Spell Checker Configuration ...................................................................................................................... 60
  Download Dictionaries .......................................................................................................................... 60
  Configure Dictionaries ........................................................................................................................... 61
Automatic QA Checks ................................................................................................................................ 62
Language Codes ....................................................................................................................................... 63
  Add Language ....................................................................................................................................... 63
  Delete Language ................................................................................................................................... 64
Auto-Save Settings .................................................................................................................................. 65
Plugins ....................................................................................................................................................... 65
  Add Plugin ............................................................................................................................................ 65
  Edit Plugin ............................................................................................................................................ 67
  Delete Plugin ........................................................................................................................................ 68
Command Line Interface .......................................................................................................................... 69
  Command Line Parameters ................................................................................................................... 69
Convert Files to XLIFF Format .................................................................................................................. 69
  Convert One Document to XLIFF Format ............................................................................................. 70
  Convert Multiple Documents to XLIFF Format ..................................................................................... 70
Create a Project File Using Swordfish ...................................................................................................... 71
File Types .................................................................................................................................................. 72
Swordfish Projects DTD ............................................................................................................................. 73
Convert XLIFF File to Original Format ...................................................................................................... 73
Leverage In-Context Exact (ICE) Matches ............................................................................................... 74
Pre-translate an XLIFF File ......................................................................................................................... 74
Mark Repeated Segments as Untranslatable/Translatable ......................................................................... 75
Mark All Segments as Translatable .......................................................................................................... 75
Export XLIFF file as TMX ........................................................................................................................ 75
Import TMX File ..................................................................................................................................... 76
Introduction

Swordfish Translation Editor

Swordfish is a cross-platform CAT (Computer Aided Translation) tool based on the XLIFF 1.2 open standard published by OASIS.

Translating with Swordfish is a process that usually requires 3 steps:

1. Conversion of source files to XLIFF format;
2. Translation of the XLIFF file;
3. Conversion of the translated XLIFF file to original format.

Swordfish can also be used to translate XLIFF files generated with other CAT tools, provided they are valid XLIFF documents and don’t include unsupported custom extensions.

Supported File Formats

With Swordfish you can translate the following document types:

<table>
<thead>
<tr>
<th>General Documentation Types</th>
<th>Software Development Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Adobe InDesign Interchange (INX)</td>
<td>• JavaScript</td>
</tr>
<tr>
<td>• Adobe InDesign IDML CS4, CS5, CS6 &amp; CC</td>
<td>• Java Properties</td>
</tr>
<tr>
<td>• HTML</td>
<td>• PO (Portable Objects)</td>
</tr>
<tr>
<td>• Microsoft Visio XML Drawings 2007/2010/2013</td>
<td>• ResX (Windows .NET Resources)</td>
</tr>
<tr>
<td>• MIF (Maker Interchange Format)</td>
<td>• TS (Qt Linguist translation source)</td>
</tr>
<tr>
<td>• OpenOffice/LibreOffice/StarOffice 1.x/2.x/3.x/4.x/5.x</td>
<td></td>
</tr>
<tr>
<td>• Plain Text</td>
<td></td>
</tr>
<tr>
<td>• RTF (Rich Text Format)</td>
<td></td>
</tr>
<tr>
<td>• SDLXLIFF (Trados Studio)</td>
<td></td>
</tr>
<tr>
<td>• Tagged RTF</td>
<td></td>
</tr>
<tr>
<td>• Trados TTX</td>
<td></td>
</tr>
<tr>
<td>• TXML (GlobalLink/Wordfast PRO)</td>
<td></td>
</tr>
<tr>
<td>• XML (Generic)</td>
<td></td>
</tr>
<tr>
<td>• XML with ready to use configuration files for:</td>
<td></td>
</tr>
<tr>
<td>– DITA 1.0, 1.1 and 1.2</td>
<td></td>
</tr>
<tr>
<td>– DocBook 3.x, 4.x and 5.x</td>
<td></td>
</tr>
<tr>
<td>– SVG</td>
<td></td>
</tr>
<tr>
<td>– Word 2003 ML</td>
<td></td>
</tr>
<tr>
<td>– XHTML</td>
<td></td>
</tr>
</tbody>
</table>
The filter for XML files supports custom configuration. Users can define conversion rules for almost any XML vocabulary.

**Supported Platforms**

- Microsoft Windows 7, 8.x and 10
- Mac OS X 10.8/10.9/10.10/10.11 (64 bit)
- Linux with GNOME desktop (64 bit)

**Features**

Swordfish features include filters for multiple document formats, full support for TMX standard, In-Context Exact Matches, versatile TM and Terminology databases, flexible licensing, segment filtering, shortcuts customization and more.

**Compatible with other CAT tools**

Swordfish supports the most common formats used for exchanging translations:

- XLIFF: Supported natively. Accepts version 1.0, 1.1 and 1.2
- Tagged (uncleaned) RTF: Accepts uncleaned RTF produced by other applications and generates uncleaned RTF from regular RTF files.
- TTX: Seamlessly converts Trados TTX files to XLIFF and back. Swordfish has built-in capabilities for segmenting TTX files.
- TXML: full round trip (TXML-> XLIFF -> TXML) of GlobalLink/Wordfast PRO files.

**In-Context Exact Matches**

Easily reuse translations by importing them from previously translated XLIFF files. Swordfish extracts translations for individual segments, considering previous and following ones as context.

**Fully Configurable**

With Swordfish you are free to customize your translation environment. You can, for example, set your preferences for:

- Fonts and colors
- Keyboard shortcuts
- Language Codes
- Segmentation Rules
- Conversion rules for XML files
- Custom XML catalogs

**Complete Segment Filtering**

Swordfish lets translators hide/show segments filtering on multiple status options, like: is translatable, has translation, has comments, is approved, etc.

**Advanced Translation Engines**

Swordfish includes two translation engines: a "traditional" TM (Translation Memory) system that provides exceptional matching and Auto-Translation, an exclusive technology that assembles matches from regular TM databases and Terminology databases.
Google's Machine Translation engine is available to Swordfish users via the embedded GTranslate plugin.

**Multiple TM and Terminology Databases**

Swordfish includes an Internal database server based on Oracle's Berkeley DB database engine. It also includes integrated support for Oracle 10g, MySQL 5.x and Microsoft SQL Server 2005/2008 for storing unlimited amounts of TM data.

You can use any number of TM and Terminology databases simultaneously in Swordfish. Additionally, you can assign custom penalties to each TM database.

**Extensible via plugins**

Swordfish has a powerful plugin architecture that lets users process individual segments or complete XLIFF documents with external applications.

**Supported Standards**

**XML Localization Interchange File Format (XLIFF)**

XML Localization Interchange File Format (XLIFF) is an XML-based open format used to exchange localisation data between participants in a translation project. This special format enables translators to concentrate on the text to be translated, without worrying about text layout.

The XLIFF vocabulary has a rich set of elements and attributes that permit XLIFF-supporting applications to:

- Store source and translated text strings.
- Store alternative or suggested translations extracted from a Translation Memory system or generated by a Machine Translation engine.
- Perform revision control.
- Keep track of the different stages of the translation process.
- Carry word count calculations.

The XLIFF standard was first published by OASIS in 2002. It is supported by a large group of localisation service providers and localisation tools providers.

XLIFF specification is available at [http://docs.oasis-open.org/xliff/xliff-core/xliff-core.html](http://docs.oasis-open.org/xliff/xliff-core/xliff-core.html).

**Translation Memory eXchange (TMX)**

TMX (Translation Memory eXchange) is the vendor-neutral open XML standard for the exchange of Translation Memory (TM) data created by Computer Aided Translation (CAT) and localization tools.

The purpose of TMX is to allow easier exchange of translation memory data between tools and/or translation vendors with little or no loss of critical data during the process.

TMX specification is available at [http://www.gala-global.org/oscarStandards/tmx/](http://www.gala-global.org/oscarStandards/tmx/).

**Segmentation Rules eXchange (SRX)**

Segmentation Rules eXchange (SRX) is the vendor-neutral standard, originally published by LISA (Localization Industry Standards Association), for describing how translation and other language-processing tools segment text for processing.
SRX is an XML vocabulary that allows Translation Memory (TM) and other linguistic tools to describe the language-specific processes by which text is broken into segments (usually sentences or paragraphs) for further processing.

SRX uses regular expressions to indicate the conditions under which a given text needs to be broken or kept as is.

SRX version 2.0 was officially accepted as an OSCAR standard in April 2008.

SRX specification is currently available at http://www.ttt.org/oscarStandards/srx/.

**Glossary Markup Language (GlossML)**

GlossML is an XML-based vocabulary specifically designed for containing glossaries that can be used for storing monolingual and multilingual lists of terms and, optionally, their definitions.

A distinctive aspect of GlossML vocabulary is its extreme simplicity. It only has 6 elements and 4 attributes. This is possible because it focuses solely on holding glossary data. It is not intended for terminology exchange.

The GlossML specification and related materials (XML Schema and examples) are licensed under the Creative Commons Attribution-No Derivative Works 3.0 Unported License. This means that anyone can use and distribute the GlossML format without paying royalties of any kind.


**TermBase eXchange (TBX)**

Term Base eXchange (TBX) is the open, XML-based standard for exchanging structured terminological data that has been approved as an international standard by LISA and ISO. It is also known as ISO 30042 standard.

TBX is a framework that allows custom definition of terminology databases. It requires two files per terminology database: one file that defines the constraints and data categories to be used (the XCS file) and a second file containing the actual data (the TBX file).

TBX is available in two flavors:

**TBX**

The official version released by ISO and LISA together. This version is based on two DTDs with a large set of XML elements and attributes. An extremely rich set of data categories is included in the default XCS file, designed to support multiple subjects through a large number of available fields.

**TBX Basic**

A limited subset of TBX, which intends to simplify the complex set of options included in the standard one. This separate version published only by LISA has its own DTD and official data categories defined in a separate XCS file.

TBX specification is available at http://www.gala-global.org/oscarStandards/tbx/tbx_oscar.pdf
User Interface

Standard Layout

Top-Down Layout
File Filtering View

Bookmarks View
## Menus

### File Menu

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open File</td>
<td>Open an existing XLIFF file for editing.</td>
</tr>
<tr>
<td>Close File</td>
<td>Close current open document.</td>
</tr>
<tr>
<td>Save File</td>
<td>Save current open document.</td>
</tr>
<tr>
<td>Save As...</td>
<td>Save current open document under a new name.</td>
</tr>
<tr>
<td>Document Properties</td>
<td>View and edit the properties of the current open document.</td>
</tr>
<tr>
<td>Convert Files to XLIFF Format</td>
<td>Create an XLIFF file from one or more documents.</td>
</tr>
<tr>
<td>Convert XLIFF File to Original Format</td>
<td>Generate translated documents from an XLIFF file.</td>
</tr>
<tr>
<td>Export File as TMX</td>
<td>Export all approved translations of current XLIFF file to TMX format.</td>
</tr>
<tr>
<td>Export Sources as Plain Text</td>
<td>Export the source text of all segments to a plain text file.</td>
</tr>
<tr>
<td>Export Targets as Plain Text</td>
<td>Export the target text of all segments to a plain text file.</td>
</tr>
<tr>
<td>Export Targets as HTML</td>
<td>Export the target text of all segments to an HTML file.</td>
</tr>
<tr>
<td>TTX Exchange</td>
<td>Display a submenu with options for exporting current open XLIFF file as TTX and importing translations from a previously exported TTX file.</td>
</tr>
<tr>
<td>Split XLIFF File</td>
<td>Split an XLIFF file into 2 or more smaller files.</td>
</tr>
<tr>
<td>Merge XLIFF Files</td>
<td>Insert the translations from 2 or more XLIFF files generated with “Split XLIFF File” option back into the original XLIFF document and save it under a new name.</td>
</tr>
<tr>
<td>Exit</td>
<td>Close the program.</td>
</tr>
</tbody>
</table>

### Edit Menu

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo Editing</td>
<td>Restore the target text of current segment to a previous state.</td>
</tr>
<tr>
<td>Set Focus on Source Text</td>
<td>Causes the source text box to have the keyboard focus.</td>
</tr>
<tr>
<td>Set Focus on Target Text</td>
<td>Causes the target text box to have the keyboard focus.</td>
</tr>
<tr>
<td>Text Buffers</td>
<td>Display a sub-menu with options that allow storage of up to 10 text fragments in memory and insertion of those fragments in target text.</td>
</tr>
<tr>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>View Text Buffers</td>
<td>View the content of the text fragments stored in memory.</td>
</tr>
<tr>
<td>Merge with Previous Segment</td>
<td>Merge the content of current segment with the previous one.</td>
</tr>
<tr>
<td>Merge with Next Segment</td>
<td>Merge the content of current segment with the following one.</td>
</tr>
<tr>
<td>Split Segment</td>
<td>Split the segment. Source text is split at cursor position.</td>
</tr>
<tr>
<td>Bookmark Segment</td>
<td>Add current segment to the list of bookmarks.</td>
</tr>
<tr>
<td>Remove Bookmark</td>
<td>Remove current segment from the list of bookmarks.</td>
</tr>
<tr>
<td>Edit Bookmark</td>
<td>Edit the text displayed in list of bookmarks for current segment.</td>
</tr>
<tr>
<td>Search/Replace</td>
<td>Search for text in source or target and optionally replace with new text.</td>
</tr>
<tr>
<td>Concordance Search</td>
<td>Search for text in a given language in the selected TM databases.</td>
</tr>
<tr>
<td>Edit Source</td>
<td>Set source text as editable to modify its content.</td>
</tr>
<tr>
<td>Accept Changes to Source</td>
<td>Save the changes done to source text.</td>
</tr>
<tr>
<td>Discard Changes to Source</td>
<td>Discard the changes done to source text and restore previous content.</td>
</tr>
<tr>
<td>Change Case</td>
<td>Change the case of target text according to selected rules.</td>
</tr>
<tr>
<td>Insert Tag</td>
<td>Display a dialog for entering the tag number to insert in target text.</td>
</tr>
<tr>
<td>Quick Tags</td>
<td>Display a sub-menu for inserting tags 1 to 10.</td>
</tr>
<tr>
<td>Insert Next Tag</td>
<td>Insert a tag with largest inserted tag number incremented by one.</td>
</tr>
<tr>
<td>Remove all Tags</td>
<td>Remove all tags present in target text.</td>
</tr>
</tbody>
</table>

**View Menu**

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full Screen Mode</td>
<td>Display the application using the entire screen or restore it to its normal size.</td>
</tr>
<tr>
<td>View Toolbar</td>
<td>Display or hide a set of buttons for performing most common operations.</td>
</tr>
<tr>
<td>Segments Filters</td>
<td>Display a dialog for selecting the segments that will be visible in the translation panel.</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Top-Down / Side-by-Side Layout</td>
<td>Toggle layout of Translation Panel between Top-Down and Side-by-Side.</td>
</tr>
<tr>
<td>Show/Hide Notes</td>
<td>Display or hide a panel containing translation notes.</td>
</tr>
<tr>
<td>Show/Hide Tags</td>
<td>Display the actual content of tags or show them in abbreviated form.</td>
</tr>
<tr>
<td>Show Match Properties</td>
<td>Display or hide a panel containing information about the selected TM match.</td>
</tr>
</tbody>
</table>

### Go To Menu

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>➡️ Next Segment</td>
<td>Display the next segment.</td>
</tr>
<tr>
<td>⬅️ Previous Segment</td>
<td>Display the previous segment.</td>
</tr>
<tr>
<td>First Segment</td>
<td>Display the first segment of the file.</td>
</tr>
<tr>
<td>Last Segment</td>
<td>Display the last segment of the file.</td>
</tr>
<tr>
<td>Go to segment...</td>
<td>Display a segment specified by its number.</td>
</tr>
<tr>
<td>Next Matching Translation</td>
<td>Bring to front the next matching translation available in the TM Matches panel.</td>
</tr>
<tr>
<td>Previous Matching Translation</td>
<td>Bring to front the previous matching translation available in the TM Matches panel.</td>
</tr>
<tr>
<td>Next Auto-Translation</td>
<td>Bring to front the next suggested translation available in the Auto-Translation panel.</td>
</tr>
<tr>
<td>Previous Auto-Translation</td>
<td>Bring to front the previous suggested translation available in the Auto-Translation panel.</td>
</tr>
<tr>
<td>Next Note in Notes Panel</td>
<td>Bring to front the next translation note available in the Notes panel.</td>
</tr>
<tr>
<td>Previous Note in Notes Panel</td>
<td>Bring to front the previous translation note available in the Notes panel.</td>
</tr>
<tr>
<td>Next Segment with Notes</td>
<td>Display the next segment that has notes.</td>
</tr>
<tr>
<td>Previous Segment with Notes</td>
<td>Display the previous segment that has notes.</td>
</tr>
<tr>
<td>Next Untranslated Segment</td>
<td>Display the next segment without translation.</td>
</tr>
<tr>
<td>Options Menu</td>
<td></td>
</tr>
<tr>
<td>---------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td><strong>User Interface Configuration</strong></td>
<td></td>
</tr>
<tr>
<td>Display a sub-menu for configuring font settings, keyboard shortcuts and system colors.</td>
<td></td>
</tr>
<tr>
<td><strong>Catalog Manager</strong></td>
<td></td>
</tr>
<tr>
<td>Display a dialog for editing the XML catalog used by the program when parsing XML files.</td>
<td></td>
</tr>
<tr>
<td><strong>XML Converter Configuration</strong></td>
<td></td>
</tr>
<tr>
<td>Display a set of dialogs for configuring the translatable elements and attributes of an XML vocabulary.</td>
<td></td>
</tr>
<tr>
<td><strong>Machine Translation Engines</strong></td>
<td></td>
</tr>
<tr>
<td>Display a dialog for configuring Google's Machine Translation Engine and Bing Translator.</td>
<td></td>
</tr>
<tr>
<td><strong>Set Minimum Match Percentage</strong></td>
<td></td>
</tr>
<tr>
<td>Display a dialog for selecting the minimum similarity value of matches automatically extracted from TM databases.</td>
<td></td>
</tr>
<tr>
<td><strong>Case Sensitive TM Search</strong></td>
<td></td>
</tr>
<tr>
<td>Select whether TM searches should be case sensitive or not.</td>
<td></td>
</tr>
<tr>
<td><strong>Case Sensitive Term Search</strong></td>
<td></td>
</tr>
<tr>
<td>Select whether term searches should be case sensitive or not.</td>
<td></td>
</tr>
<tr>
<td><strong>Fuzzy Term Searches</strong></td>
<td></td>
</tr>
<tr>
<td>Select whether term searches allow retrieval of non-exact matched terms or not.</td>
<td></td>
</tr>
<tr>
<td><strong>Automatic Auto-Translation</strong></td>
<td></td>
</tr>
<tr>
<td>Enable or disable automatic generation of Auto-Translations for untranslated segments or segments without perfect TM matches.</td>
<td></td>
</tr>
<tr>
<td><strong>Apply TM in Background</strong></td>
<td></td>
</tr>
<tr>
<td>Select whether the program should retrieve TM matches from enabled databases for untranslated segments as a background task or not.</td>
<td></td>
</tr>
<tr>
<td><strong>Correct Spaces when Accepting Translations</strong></td>
<td></td>
</tr>
<tr>
<td>Enable or disable the automatic insertion or removal of trailing or initial spaces when accepting matches from TM Matches panel or Auto-Translation panel.</td>
<td></td>
</tr>
<tr>
<td><strong>Copy Source to Target on No Match</strong></td>
<td></td>
</tr>
<tr>
<td>Enable or disable automatic copy of source text to target when there are no matches in the segment or TM databases.</td>
<td></td>
</tr>
<tr>
<td><strong>Automatic QA Checks</strong></td>
<td></td>
</tr>
<tr>
<td>Display a sub-menu for selecting the quality assurance checks to apply automatically after approving a segment.</td>
<td></td>
</tr>
<tr>
<td>Task</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Change Language Code</td>
<td>Display a dialog for editing the existing language codes supported by the application.</td>
</tr>
<tr>
<td>Apply TM to Current Segment</td>
<td>Search for a suitable match for current segment in the enabled TM databases.</td>
</tr>
<tr>
<td>Apply TM to all Segments</td>
<td>Search for suitable matches for all segments in the enabled TM databases.</td>
</tr>
<tr>
<td>Auto-Translate Current Segment</td>
<td>Assemble an Auto-Translation for current segment using the enabled TM and Terminology databases.</td>
</tr>
<tr>
<td>Auto-Translate all Segments</td>
<td>Assemble Auto-Translators for all segments using the enabled TM and Terminology databases.</td>
</tr>
<tr>
<td>Translate Current Segment Using MT</td>
<td>Request translations for current segment from the enabled Machine Translation engines.</td>
</tr>
<tr>
<td>Apply MT to all Segments</td>
<td>Apply Machine Translation to all unapproved segments using the enabled MT engines.</td>
</tr>
<tr>
<td>Leverage In-Context Exact Matches</td>
<td>Extract and reuse in-context exact matches from a previously translated XLIFF file.</td>
</tr>
<tr>
<td>Copy Source to Target</td>
<td>Copy text and tags from source text box to target text box.</td>
</tr>
<tr>
<td>Copy Sources to All Empty Targets</td>
<td>Place a copy of source text and tags in the target of all untranslated segments.</td>
</tr>
<tr>
<td>Pseudo-translate Untranslated Segments</td>
<td>Place a fake translation, generated replacing vowels with accented characters, in the target of all untranslated segments.</td>
</tr>
<tr>
<td>Approve/Unapprove Segment</td>
<td>Mark current segment as approved/unapproved.</td>
</tr>
<tr>
<td>Approve and go to Next Untranslated</td>
<td>Mark current segment as approved and go to next unapproved segment.</td>
</tr>
</tbody>
</table>

**Tasks Menu**

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Language Code</td>
<td>Display a dialog for changing source or target languages in the current XLIFF file.</td>
</tr>
<tr>
<td>Apply TM to Current Segment</td>
<td>Search for a suitable match for current segment in the enabled TM databases.</td>
</tr>
<tr>
<td>Apply TM to all Segments</td>
<td>Search for suitable matches for all segments in the enabled TM databases.</td>
</tr>
<tr>
<td>Auto-Translate Current Segment</td>
<td>Assemble an Auto-Translation for current segment using the enabled TM and Terminology databases.</td>
</tr>
<tr>
<td>Auto-Translate all Segments</td>
<td>Assemble Auto-Translators for all segments using the enabled TM and Terminology databases.</td>
</tr>
<tr>
<td>Translate Current Segment Using MT</td>
<td>Request translations for current segment from the enabled Machine Translation engines.</td>
</tr>
<tr>
<td>Apply MT to all Segments</td>
<td>Apply Machine Translation to all unapproved segments using the enabled MT engines.</td>
</tr>
<tr>
<td>Leverage In-Context Exact Matches</td>
<td>Extract and reuse in-context exact matches from a previously translated XLIFF file.</td>
</tr>
<tr>
<td>Copy Source to Target</td>
<td>Copy text and tags from source text box to target text box.</td>
</tr>
<tr>
<td>Copy Sources to All Empty Targets</td>
<td>Place a copy of source text and tags in the target of all untranslated segments.</td>
</tr>
<tr>
<td>Pseudo-translate Untranslated Segments</td>
<td>Place a fake translation, generated replacing vowels with accented characters, in the target of all untranslated segments.</td>
</tr>
<tr>
<td>Approve/Unapprove Segment</td>
<td>Mark current segment as approved/unapproved.</td>
</tr>
<tr>
<td>Approve and go to Next Untranslated</td>
<td>Mark current segment as approved and go to next unapproved segment.</td>
</tr>
<tr>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Mark current segment as approved and go to next unapproved segment.</td>
<td>Mark current segment as approved and go to next unapproved segment.</td>
</tr>
<tr>
<td>Store the translation of current segment in the designated write-enabled TM Database.</td>
<td>Store the translation of current segment in the designated write-enabled TM Database.</td>
</tr>
<tr>
<td>Copy the foremost translation from the TM Matches panel to target text box.</td>
<td>Copy the foremost translation from the TM Matches panel to target text box.</td>
</tr>
<tr>
<td>Copy the foremost translation from the TM Matches panel to target text box, excluding all tags.</td>
<td>Copy the foremost translation from the TM Matches panel to target text box, excluding all tags.</td>
</tr>
<tr>
<td>Copy the foremost translation from the Auto-Translation panel to target text box.</td>
<td>Copy the foremost translation from the Auto-Translation panel to target text box.</td>
</tr>
<tr>
<td>Copy the foremost translation from the Auto-Translation panel to target text box, excluding all tags.</td>
<td>Copy the foremost translation from the Auto-Translation panel to target text box, excluding all tags.</td>
</tr>
<tr>
<td>Add a mark to the corresponding database entry of the translation displayed in the TM Matches panel.</td>
<td>Add a mark to the corresponding database entry of the translation displayed in the TM Matches panel.</td>
</tr>
<tr>
<td>Display a dialog for setting the length in characters allowed for current or all segments.</td>
<td>Display a dialog for setting the length in characters allowed for current or all segments.</td>
</tr>
<tr>
<td>Toggle the status of current segment between translatable and untranslatable.</td>
<td>Toggle the status of current segment between translatable and untranslatable.</td>
</tr>
<tr>
<td>Mark all repeated segments of current XLIFF as untranslatable, leaving only one copy as translatable.</td>
<td>Mark all repeated segments of current XLIFF as untranslatable, leaving only one copy as translatable.</td>
</tr>
<tr>
<td>Change the status of all untranslatable segments to translatable.</td>
<td>Change the status of all untranslatable segments to translatable.</td>
</tr>
<tr>
<td>Mark all segments that have translation as approved.</td>
<td>Mark all segments that have translation as approved.</td>
</tr>
<tr>
<td>Mark all segments as unapproved.</td>
<td>Mark all segments as unapproved.</td>
</tr>
<tr>
<td>Remove the existing translations from all segments.</td>
<td>Remove the existing translations from all segments.</td>
</tr>
<tr>
<td>Remove all TM matches, Auto-Translations and auto-propagated matches from the current file.</td>
<td>Remove all TM matches, Auto-Translations and auto-propagated matches from the current file.</td>
</tr>
<tr>
<td>Automatically copy to target the first perfect translation for all segments containing 100% matches.</td>
<td>Automatically copy to target the first perfect translation for all segments containing 100% matches.</td>
</tr>
<tr>
<td>Automatically copy to target the first perfect translation and mark the segment as approved for all segments containing 100% matches.</td>
<td>Automatically copy to target the first perfect translation and mark the segment as approved for all segments containing 100% matches.</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>XSL Transformation</strong></td>
<td>Display a dialog for applying XSL transformations to an XML file.</td>
</tr>
</tbody>
</table>

### Terminology Menu

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Add Selection to Default Terminology Database</strong></td>
<td>Import the text selected in source and target into the write-enabled Terminology database.</td>
</tr>
<tr>
<td><strong>Add New Entry to Default Terminology Database</strong></td>
<td>Display a dialog for adding a new term entry to the write-enabled Terminology database.</td>
</tr>
<tr>
<td><strong>Search Term in Terminology Databases</strong></td>
<td>Display a dialog for searching a term in the enabled Terminology databases.</td>
</tr>
<tr>
<td><strong>Search Term on the Web</strong></td>
<td>Display a dialog for searching a term on the Internet.</td>
</tr>
<tr>
<td><strong>Insert Selected Term</strong></td>
<td>Copy to target the term currently selected in the Terminology panel.</td>
</tr>
<tr>
<td><strong>Insert Terms...</strong></td>
<td>Display a sub-menu for inserting terms 1 to 10 from the Terminology panel into target text.</td>
</tr>
</tbody>
</table>

### Database Menu

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Create Database</strong></td>
<td>Display a dialog for creating a new TM or Terminology database.</td>
</tr>
<tr>
<td><strong>Browse Database Server</strong></td>
<td>Display a dialog for selecting the database server to examine for new or existing databases.</td>
</tr>
<tr>
<td><strong>Remove Database from Working List</strong></td>
<td>Display a dialog for removing a selected database from the list of databases that the program can use.</td>
</tr>
<tr>
<td><strong>Import TMX File</strong></td>
<td>Import the content of a TMX file into a TM or Terminology database.</td>
</tr>
<tr>
<td><strong>Import CSV File</strong></td>
<td>Import the content of a CSV (Comma Separated Values) file into a TM or Terminology database.</td>
</tr>
<tr>
<td><strong>Export Database as TMX</strong></td>
<td>Export the contents of a database to TMX format.</td>
</tr>
<tr>
<td><strong>Export all Databases as TMX</strong></td>
<td>Export the contents of all databases to TMX format.</td>
</tr>
<tr>
<td><strong>Import GlossML File</strong></td>
<td>Import the content of a glossary in GlossML format into a TM or Terminology database.</td>
</tr>
<tr>
<td>Import TBX File</td>
<td>Import the content of a TBX file into a TM or Terminology database.</td>
</tr>
<tr>
<td>-----------------</td>
<td>---------------------------------------------------------------------</td>
</tr>
<tr>
<td>Select TM Databases</td>
<td>Display a dialog for selecting the TM databases to use as reference.</td>
</tr>
<tr>
<td>Select Terminology Databases</td>
<td>Display a dialog for selecting the Terminology databases to use as reference.</td>
</tr>
</tbody>
</table>

**QA Menu**

<table>
<thead>
<tr>
<th>Preview Translation</th>
<th>Display all segments and their translations in the default HTML browser.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Translation Status Analysis</td>
<td>Generate statistics of current XLIFF file and display them in the default HTML browser.</td>
</tr>
<tr>
<td>Translation Status History</td>
<td>Display the history of translation status changes.</td>
</tr>
<tr>
<td>Tags Analysis</td>
<td>Display a dialog with a report of segments with errors in tags.</td>
</tr>
<tr>
<td>Terminology Consistency Analysis</td>
<td>Display a dialog for performing a terminology check against a glossary or a Terminology database.</td>
</tr>
<tr>
<td>Leading/Trailing Spaces Analysis</td>
<td>Display a dialog that reports segments with differences in initial or trailing spaces between source and target text.</td>
</tr>
<tr>
<td>Spell Check Segment</td>
<td>Check the spelling of current translation and display a dialog for correcting errors if necessary.</td>
</tr>
<tr>
<td>Spell Check Document</td>
<td>Check the spelling of all translations and display a dialog for correcting errors if necessary.</td>
</tr>
</tbody>
</table>

**Plugins Menu**

| Plugin Configuration | Display a dialog for configuring the different programs made available as plugins. |

**Help Menu**

<table>
<thead>
<tr>
<th>Swordfish Help</th>
<th>Display Swordfish User Guide in the default PDF viewer.</th>
</tr>
</thead>
<tbody>
<tr>
<td>License Management</td>
<td>Display a dialog for licensing the program.</td>
</tr>
<tr>
<td>Check for Updates</td>
<td>Verify the availability of newer versions of the program.</td>
</tr>
<tr>
<td>About...</td>
<td>Display a dialog with license status and program version information.</td>
</tr>
</tbody>
</table>
Getting Started

Translation Workflow

Swordfish uses XLIFF 1.2 as intermediate format for translating documents.

Source documents need to be converted to XLIFF 1.2 format in order to be translated. After translating an XLIFF document created by Swordfish, it has to be converted to original format to generate translated versions of the source files.

A standard translation workflow has these three steps:

1. Convert source files to XLIFF format
2. Translate the XLIFF file generated in previous step
3. Convert the translated XLIFF file to original format

Convert Files to XLIFF Format

Steps for converting one or more documents to XLIFF format for translating in Swordfish.

Procedure

1. In File menu, select Convert Files to XLIFF Format or click the button.

   The following dialog appears:

   ![Convert Files to XLIFF Format dialog](image)

   2. Select the source language of the XLIFF file using the Source Language drop-down list.

   3. Select the target language of the XLIFF file using the Target Language drop-down list.

   4. Add all files that need translation using the buttons that appear below the files list.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Files</td>
<td>Display a file selection dialog for selecting one or more files from the file system.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Add Directory</td>
<td>Display a dialog for selecting a directory from the file system. All its files and sub-directories are added to the list.</td>
</tr>
<tr>
<td>Delete Selected Files</td>
<td>Delete from the list all files that have its check box selected.</td>
</tr>
</tbody>
</table>

You can also drag files and drop them into the files list.

5. Use the drop-down lists next to each file to select or correct the file type and character set of the document.

6. Type a name for the XLIFF file to generate in the XLIFF File text box or use the Browse... button to select a file name and location.

7. Optionally, enter a project description or select an existing one in the Project Description drop-down list.

8. Optionally, enter a customer name or select an existing one in the Customer drop-down list.

9. Optionally, enter a subject description or select an existing one in the Subject drop-down list.

10. Check the Paragraph Segmentation check box if you want the text to be segmented at paragraph level. Leave it unchecked for sentence level segmentation.

11. Check the Break Segment on Every CR/LF (Plain Text Files) check box if you want every carriage return or linefeed character to be used as segment delimiter in plain text files.

12. Check the Embed Skeletons in XLIFF File check box if you the skeletons required for generating translated files to be included in the XLIFF document.

13. Type the name of the SRX file to use during segmentation in the SRX Rules text box or click the Browse... button to select an SRX file from the file system.

14. Check the Open XLIFF File After Conversion check box if you want to automatically open the generated XLIFF file in Swordfish after conversion finishes.

15. Click the Convert Files button.

**Results**

An XLIFF file is generated from the selected documents.

**Translating XLIFF Files**

Use the Open File option from File menu or click the Open button to open the XLIFF file you wish to translate.

Select the Target Text text box in the Translation Panel and start typing your translation.
Source formatting is represented with green marks with a number (i.e.: [0x0]) in source text. To insert green marks, also known as tags, press Ctrl + N, where N is the number in the mark. You can also use the Insert Tag button (<> from the Translation Panel) to display a dialog that asks for a tag number or one of the the Insert Tag options from Edit Menu.

When the segment is fully translated, press Ctrl + E or click on the Approve Segment button (✓) that is below the target. When you approve the segment, its translation is stored in the Write-enabled Database currently selected and is also automatically propagated to all similar unapproved segments.

You have two more options for marking a segment as approved:

- Press Alt + Down Arrow or click the button to Approve and go to Next Untranslated segment;
- Press Alt + Shift + Down Arrow or click the button to Approve and go to Next Unapproved segment.

Use PgUp and PgDn keys or the arrows in the Translation Panel (< and >) to move to the next or previous segments and translate them.

When all segments have been translated, press F5 or use the Preview Translation option from QA (Quality Assurance) menu to review your translations. Note any segment with errors and correct them.

To visit a segment knowing its number, you can type the number in the text box that contains current segment number (the one between the blue arrows) and press Enter.

Finally, use the Tag Analysis option from QA menu to check that your file is properly translated. Pay special attention to errors in tags, because the translated document may become unusable.

**Convert XLIFF File to Original Format**

Steps for generating translated documents from an XLIFF file.
Procedure

1. In **File** menu, select **Convert XLIFF File to Original Format** or click the button.

   The following dialog appears:

   ![Convert XLIFF File to Original Format dialog]

   - Type the name of the XLIFF file to convert in the **XLIFF File** text box or click the **Browse...** button next to it to select an XLIFF file from the file system.
   - If the XLIFF file was generated from multiple documents, type the name of the directory in which to store translated documents in the **Output Folder** text box or use the **Browse...** button next to it to select a directory from the file system.
   - If the XLIFF file was generated from a single document, type the name of the translated file in the **Output File** text box or click the **Browse...** button next to it to select a file name and location. Optionally, check the **Open File After Conversion** check box to open the translated file after conversion with the default application configured in the operating system.
   - If you want to store all translations from the XLIFF file in a TM database, check the **Store Translations in Database** check box and select a database from the drop-down list below it.
   - Click the **Convert XLIFF File to Original Format** button.

Results

One or more translated documents are generated and, optionally, translations are stored in the selected database.

Useful Options

Concordance Search

Procedure

1. In **Edit** menu, select **Concordance Search** or click the button.

   The following dialog appears:
2. Type the text to search in the **Search for** text box.

3. Select the language of the text to be searched in the **Language** drop-down list.

4. Select the maximum number of matches to display in the **Entries to Display** drop-down list.

5. Check the **Case Sensitive Search** box if you want to find matches with the same text case only. Uncheck it otherwise.

6. Check the **Regular Expressions** box if the text entered in the **Search for** text box should be treated as a regular expression. Uncheck it otherwise.

7. Click the **Concordance Databases** button.

   The following dialog appears:

![Concordance Databases dialog](image)

8. In the **Concordance Databases** dialog, check the boxes at the left of all databases that you want to include in the search.

9. Click the **Select Databases** button in the **Concordance Databases** dialog to close it saving your preferences.

10. Click the **Search Text** button.

   The following dialog showing the results with the searched text highlighted appears:
Segment Filtering

About this task

Swordfish allows you to hide segments that you don't need to see at translation time. It provides multiple selection options based on segment status or content.

Procedure

1. In View menu, select Segment Filters or click the button.

   The following dialog appears:

   ![Segment Filtering Dialog](image)

2. To show only segments whose source text matches a given regular expression, select the Filter Source check box and enter the desired regular expression in the text box next to it.
For example, the expression "[0-9|\.|,|\$|%]+" makes visible only segments with numeric expressions in source text.

3. To show only segments whose target text matches a given regular expression, select the Filter Target check box and enter the desired regular expression in the text box next to it.

4. Review all check boxes and select those that represent segments that you want to remain visible.

5. Click the Set Filters button.

Results
All segments that don't comply with the indicated selection criteria are hidden. When no segment matches the filtering criteria, filter options are automatically reset and all segments are shown.
Database Management

Supported Databases

Swordfish uses databases to store translations and terms. It supports the following database engines:

**Internal**
- Embedded database engine. Included with Swordfish and no additional setup is required to use it.

**RemoteTM**
- A multi-user web-based server that allows sharing the Internal database engine used by Swordfish over the Internet. See RemoteTM Web Server for more details.

**Oracle 10g/11g**

**MySQL 5.x**
- MySQL is a multi-platform database engine that works on Windows, Linux and Mac OS X. Free versions for non-commercial use are available for download at: http://www.mysql.com/downloads/

Databases created using the Internal database engine cannot be shared between different computers in a network. All other supported engines can be used to share databases across a LAN or the Internet.

Create Database

Steps for creating a database in Swordfish.

Procedure

1. In **Database** menu, select **Create Database**.

   The following dialog appears:

   ![Create Database Dialog](image)

2. In the **Database Name** text box enter a name for the database.

   Only latin characters, numbers and underscores are allowed in a database name.

3. Select a database type using the **Database Type** drop-down list. Available options are:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internal</td>
<td>Swordfish’s internal database engine.</td>
</tr>
</tbody>
</table>
**Option** | **Description**
---|---
RemoteTM | A multi-user web-based server that allows sharing the Internal database engine over the Internet. See RemoteTM Web Server for more details.
MySQL 5.x | Open source database available for Windows, Linux and Mac OS X.
Oracle | Commercial database engine available for Windows, Linux and Mac OS X Server.

4. If the database type selected in previous step is Oracle, type the name of the database or database instance in the Instance/DB text box.

5. Type the server name or IP in the Server Name text box.
   This step is not required for Internal database type.

6. Type the port in which the database server accepts requests in the Port Number text box.
   This step is not required for Internal database type.

7. Type the name of a user authorized to access the database in the User Name text box.
   This step is not required for Internal database type.

8. Type the password corresponding to the selected user in the Password text box.
   This step is not required for Internal database type.

9. Click the Accept button to create the database.
   A confirmation dialog is displayed.

**Results**
A database with the given name is created in the selected database server.

**Select TM Databases**

**Procedure**

1. In Database menu, select Select TM Databases or click the button.
   The following dialog appears:
2. Select the check boxes that appear at the left of the databases that you wish to enable for TM lookup. Unmark the boxes of those databases that you no longer wish to use.

3. Optionally, select a database for storing translations from the Write-Enabled Database drop-down list.

4. If you wish to assign a penalty to one or more databases, follow these steps:
   a. Select the databases in the database list.
   b. Click the Set Match Penalty button.
      The following dialog appears:

   c. Type the penalty percentage in the Penalty Percentage text box.
   d. Click the Accept button.

5. Click the Set Match Penalty button.

### Remove Database from Working List

Remove a database from the list of databases that can be selected for working, without removing its data.

**Procedure**

1. In Database menu, select Remove Database from Working List.
   The following dialog appears:

2. Select the database you wish to remove.
3. Click the Remove Database button.

**Results**

The selected database is removed from the list of databases that are available for working, but the data is preserved.
Remove Database Permanently

Procedure

1. In Database menu, select Browse Database Server.

   The following dialog appears:

   ![Database Browser]

2. Select a database type using the Database Type drop-down list. Available options are:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internal</td>
<td>Swordfish's internal database engine.</td>
</tr>
<tr>
<td>RemoteTM</td>
<td>A multi-user web-based server that allows sharing the Internal database engine over the Internet. See RemoteTM Web Server for more details.</td>
</tr>
<tr>
<td>MySQL 5.x</td>
<td>Open source database available for Windows, Linux and Mac OS X.</td>
</tr>
<tr>
<td>Oracle</td>
<td>Commercial database engine available for Windows, Linux and Mac OS X Server.</td>
</tr>
</tbody>
</table>

3. If the database type selected in previous step is Oracle, type the name of the database or database instance in the Instance/DB text box.

4. Type the server name or IP in the Server Name text box.

   This step is not required for Internal database type.

5. Type the port in which the database server accepts requests in the Port Number text box.

   This step is not required for Internal database type.

6. Type the name of a user authorized to access the database in the User Name text box.

   This step is not required for Internal database type.

7. Type the password corresponding to the selected user in the Password text box.

   This step is not required for Internal database type.

8. Click the Browse... button.

   The following dialog appears:
9. Select the database that you want to remove in the database list.

10. Click the **Physically Remove Database** button.
    
    A confirmation dialog appears.

11. Confirm the delete operation.

### Add Existing Database to Working List

**Procedure**

1. In **Database** menu, select **Browse Database Server**.

   The following dialog appears:

2. Select a database type using the **Database Type** drop-down list. Available options are:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internal</td>
<td>Swordfish's internal database engine.</td>
</tr>
<tr>
<td>RemoteTM</td>
<td>A multi-user web-based server that allows sharing the <strong>Internal</strong> database engine over the Internet. See <strong>RemoteTM Web Server</strong> for more details.</td>
</tr>
<tr>
<td>MySQL 5.x</td>
<td>Open source database available for Windows, Linux and Mac OS X.</td>
</tr>
<tr>
<td>Oracle</td>
<td>Commercial database engine available for Windows, Linux and Mac OS X Server.</td>
</tr>
</tbody>
</table>

3. If the database type selected in previous step is **Oracle**, type the name of the database or database instance in the **Instance/DB** text box.

4. Type the server name or IP in the **Server Name** text box.
This step is not required for **Internal** database type.

5. Type the port in which the database server accepts requests in the **Port Number** text box.
   This step is not required for **Internal** database type.

6. Type the name of a user authorized to access the database in the **User Name** text box.
   This step is not required for **Internal** database type.

7. Type the password corresponding to the selected user in the **Password** text box.
   This step is not required for **Internal** database type.

8. Click the **Browse...** button.

   The following dialog appears:

   ![](image)

   9. Select the database that you want to add to the working list. Databases currently not included in working list are shown in red.

10. Click the **Add Database to Working List** button.

11. Close the confirmation dialog that appears.

**Import TMX File**

**Procedure**

1. In **Database** menu, select **Import TMX File**.

   The following dialog appears:
2. Type the name of the TMX file to import in the **TMX File** text box or use the **Browse**... button next to it to select a TMX file from the file system.

3. Select the database that will receive the TM data in the **Database Name** drop-down list.

4. Select the import options to use.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remove Invalid Characters</td>
<td>Check this option to remove from the selected TMX file all characters not allowed by the XML standard before importing it.</td>
</tr>
<tr>
<td>Append Entries (Fast)</td>
<td>Segments are imported without checking for duplicates or similar previous entries.</td>
</tr>
<tr>
<td>Update Existing Similar Entries (Slow)</td>
<td>The program searches for duplicates or similar existing segments and updates them in the database. The TMX file must have source language set to a real language code, not &quot;<em>all</em>&quot;.</td>
</tr>
</tbody>
</table>

5. Optionally, enter a project description or select an existing one in the **Project** drop-down list.

6. Optionally, enter a customer name or select an existing one in the **Customer** drop-down list.

7. Optionally, enter a subject description or select an existing one in the **Subject** drop-down list.

8. Click the **Import TMX File** button.

**Import CSV File**

**About this task**

CSV (Comma Separated Values) is a standard format for storing tabular data. Before importing a CSV file you need to know certain details about it:

- Column Separator: the character used to separate data columns in the CSV file. The most common separators are comma and tab characters.

- Text Delimiter: characters used to enclose column data. Delimiters are used when the data can contain the character used as column separator.
• Character Set: the encoding used for writing the CSV file. The most common options are: UTF-16, UTF-8 and Windows-1252.

Use a text editor to examine the CSV file and obtain the necessary details.

Procedure

1. In Database menu, select Import CSV File.

   The following dialog appears:

   2. Type the name of the CSV file to import in the CSV File text box or use the Browse... button next to it to select a CSV file from the file system.

   3. Select the database that will receive the TM data in the Database drop-down list.

   4. Select the character set of the CSV file from the Character Set drop-down list.

   5. Type a column separator or select a standard value in the Column Separator drop-down list.

   6. Type a text delimiter or select a standard value in the Text Delimiter drop-down list.

   7. Select a column from the Columns list and click on the Set Column Type button.

   The following dialog appears:

29
8. In the **Column Type** dialog, select the type of column and, if required, select the language of the column.

9. Click **Save Column Type** button to close the **Column Type** dialog.

   The corresponding column type and language will be displayed in the **Columns** list and the **Preview** panel will be updated.

10. Repeat the previous 3 steps until all columns have a type assigned.

11. Click the **Import CSV File** button.

### Import GlossML File

**Procedure**

1. In **Database** menu, select **Import GlossML File**.

   The following dialog appears:

2. Type the name of the GlossML file to import in the **GlossML File** text box or use the **Browse...** button next to it to select a GlossML file from the file system.

3. Select the database that will receive the glossary data in the **Database Name** drop-down list.

4. Click the **Import GlossML File** button.

### Import TBX File

**Procedure**

1. In **Database** menu, select **Import TBX File**.

   The following dialog appears:

2. Type the name of the TBX file to import in the **TBX File** text box or use the **Browse...** button next to it to select a TBX file from the file system.

3. Select the database that will receive the terminology data in the **Database Name** drop-down list.

4. Click the **Import TBX File** button.
Terminology Management

Select Terminology Databases

Procedure

1. In Database menu, select Select Terminology Databases or click the button. The following dialog appears:

   ![Terminology Databases Menu]

2. Select the check boxes that appear at the left of the databases that you wish to enable for terminology lookup. Unmark the boxes of those databases that you no longer wish to use.

3. Optionally, select a database for storing terms from the Write-Enabled Database drop-down list.

4. Click the Select Databases button.

Add Term To Database

Procedure

1. In Terminology menu, select Add New Entry to Default Terminology Database or click the button. The following dialog appears:

   ![Add Term to Database]

2. Type the source term in the Source Term text box.

3. Type the target term in the Target Term text box.

4. Select the source language from the Source Language drop-down list.
5. Select the target language from the **Target Language** drop-down list.
6. Click the **Add Term** button.

### Add Selection to Database

**Procedure**

1. In the source text box, select the term that you want to store in the database.
2. In the target text box, select the translation of the term being stored.
3. In **Terminology** menu, select **Add Selection to Default Terminology Database** or click the button.

**Results**

A message is displayed in the status bar indicating that the term has been added to the write-enabled terminology database.

### Search Terms on the Web

Swordfish allows you to search terms on a set of user configurable web sites and displays the search results in its internal web browser.

**Procedure**

1. In the **Terminology** menu, select **Search term on the Web** or click the button.

   The following dialog appears:

   ![Search Term on the Web dialog]

2. Type the text to search in the **Term** text box.
3. Select the web site in which to search from the **Web Site** drop-down list.
4. Click the **Search Term** button.

**Results**

A dialog appears, displaying the results provided by the selected web site.

### Web Sites Configuration

**Procedure**

1. In **Terminology** menu, select **Search term on the Web** or click the button.

   The following dialog appears:
2. Click the Configure Web Sites button.

The following dialog appears:

3. Use the buttons that appear at the bottom of the dialog to add, edit or remove web sites from the list.

Add Web Site

Procedure

1. Click the Add Web Site button

The following dialog appears:

2. Type a description for the web site in the Description text box.

3. Type the URL of the web site, including all required parameters, in the URL text box. Enter "%%%TERM%%%" in the section of the URL where the term to search should be included.

4. Select the separator to use when searching for multiple words in the Word Separator box.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plus Signs</td>
<td>All spaces between words are replaced by plus signs (+).</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>Underscores</td>
<td>All spaces between words are replaced with underscore characters (._).</td>
</tr>
<tr>
<td>Spaces</td>
<td>All spaces between words are replaced with &quot;%20&quot; (standard representation for spaces in URLs).</td>
</tr>
</tbody>
</table>

5. Click the **Save Web Site** button.

## Results

A new web site is added to the list.

## Edit Web Site

### Procedure

1. Select the web site to edit from the list displayed in the **Web Sites** dialog.

2. Click the **Edit Web Site** button.

   The following dialog appears:

   ![Web Site Dialog](image)

3. Adjust the displayed values as required.

4. Click the **Save Web Site** button.

## Results

The selected web site is updated with the modifications entered.

## Remove Web Site

### Procedure

1. Select the web site to remove from the list displayed in the **Web Sites** dialog.

2. Click the **Remove Web Site** button.

3. Confirm the removal operation.

## Results

The selected web site is removed from the list.
License Management

License Keys

A License Key is a short text code required to continue using the application after the 30 days evaluation period.

License Keys can be purchased at http://www.maxprograms.com/store/buy.html

Note

- Registering or disabling a License Key requires an Internet connection.
- Registration data is sent to the server using TCP/IP protocol on port 9080. Open this port on your firewall during registration or the operation will fail.
- Always disable your license key before reformattting your hard disk or changing operating system.

Request an Evaluation License

About this task

You can evaluate the program for free during 30 days before purchasing a License Key. All features are enabled during the evaluation period.

Procedure

1. When you start the program for the first time, the following dialog appears:

2. If your computer uses a proxy server to connect to the Internet, follow these steps to configure the proxy server settings:
   a. Click the Proxy Settings button.
      The following dialog appears:
b. Type the proxy server name or IP in the **Server** text box.

c. Type the proxy port number in the **Port** text box.

d. If your proxy server requires authentication, type the proxy user name in the **User ID** text box and the corresponding password in the **Password** text box.

e. Click the **Save Settings** button.

Selected proxy settings are saved and the dialog closes.

3. Click the **Start Trial** button.

**Results**

Your evaluation license request is sent to the Registration Server and your computer is enabled to work with the application for 30 days.

**Register a License Key**

**Procedure**

1. When you start the program after the trial period has ended, after installing an upgrade or after disabling a License Key, the following dialog appears:

![License Management dialog](image1)

2. Type your license code in the **License Key** text box.

3. If your computer uses a proxy server to connect to the Internet, follow these steps to configure the proxy server settings:

a. Click the **Proxy Settings** button.

The following dialog appears:

![Proxy Settings dialog](image2)

b. Type the proxy server name or IP in the **Server** text box.

c. Type the proxy port number in the **Port** text box.

d. If your proxy server requires authentication, type the proxy user name in the **User ID** text box and the corresponding password in the **Password** text box.
4. Click the **Register License** button.

**Results**

Your license key code is sent to the Registration Server and your computer is enabled to work with the registered application.

---

### Disable a License Key

**Procedure**

1. In the **Help** menu, select **License Management**.

   The following dialog appears:

   ![License Management Dialog](image1)

   2. If your computer uses a proxy server to connect to the Internet, follow these steps to configure the proxy server settings:

   a. Click the **Proxy Settings** button.

      The following dialog appears:

      ![Proxy Settings Dialog](image2)

   b. Type the proxy server name or IP in the **Server** text box.

   c. Type the proxy port number in the **Port** text box.

   d. If your proxy server requires authentication, type the proxy user name in the **User ID** text box and the corresponding password in the **Password** text box.

   e. Click the **Save Settings** button.

3. Click the **Disable License** button.

**Results**

Your license key code is sent to the Registration Server and the application becomes disabled.
Transfer a License Key
Steps for transferring a working license key to a different computer.

Procedure
1. Start the application in the computer where it is enabled.
2. Disable the license key.
3. Start the application in the computer that you want to use next.
4. Enable the license key.

Results
Your license key is transferred from one computer to another.
Quality Assurance

Quality Assurance Options

Swordfish offers several options for monitoring the quality and status of your translation work.

- Use the **Translation Preview** option to proofread your work.
- Use the **Translation Status Analysis** option to check the translation status of an XLIFF file or to prepare quotes for translation jobs.
- Use the **Translation Status History** option to track the progress of a translation tasks.
- Use the **Tags Analysis** option to find segments with wrong or missing tags.
- Use the **Terminology Consistency Analysis** option to validate the terms used in a translation against a glossary stored in a Terminology database.
- Use the **Leading/Trailing Spaces Analysis** to verify that target text contains the same leading and trailing spaces as source text.
- Use the **Spell Check Segment** option to verify the spelling of a single segment.
- Use the **Spell Check Document** option to verify the spelling of all segments in an XLIFF file.

Translation Preview

Display the content of an XLIFF file in a web browser for comfortable review. The HTML content displayed in the browser is controlled by an XSL stylesheet that can be customized as desired.

**Procedure**

1. In **File** menu, select **Open File** or click the button.
2. Locate and open the XLIFF file to be reviewed.
3. In the **QA** menu, select **Preview Translation** or click the button.

   The following dialog appears:

   4. Check the **Show Tags** box if you want tags to be displayed in the preview.
   5. Check the **Show Notes** box if you want existing notes to be displayed in the preview.
   6. Click the **Preview Translation** button.

**Results**

An HTML page with preview data is generated and opened in the default web browser.
Translation Status Analysis

Procedure

1. In File menu, select Open File or click the button.
2. Locate and open the XLIFF file to be analyzed.
3. In QA menu, select Translation Status Analysis or click the button.

A web page with detailed statistics showing word counts, TM matches and translation status for the current XLIFF file is generated and automatically displayed using the default web browser.

Translation Status History

Procedure

1. In File menu, select Open File or click the button.
2. Locate and open the XLIFF file to be analyzed.
3. In QA menu, select Translation Status History.

The following dialog appears:

4. Click the View History button to generate a web page containing all saved statistic reports and display it in the default web browser.
5. Click the Add Current Status button to calculate current translation statistics and store them in the XLIFF file. The following dialog appears:

   a. Type a description of current translation stage in the Description text box.
   b. If necessary, adjust the date displayed in the Date text box.
   c. Click the Add Status button.

Current translations statistics are generated and saved in the XLIFF file. A new entry is added to the list of recorded statistics.
Tag Analysis

Procedure

1. In QA menu, select **Tags Analysis** or click the button.

   The following dialog appears:

   ![Tags Analysis](image)

2. Select an error entry from the list.

3. Click the **Go To** button to open the segment with tag errors.

4. Correct all tag errors in the segment.

5. Click the **Refresh** button to review the file and update the list of errors.

6. Repeat previous steps until all errors are fixed.

Terminology Consistency Analysis

Procedure

1. In QA menu, select **Terminology Consistency Analysis** or click the button.

   The following dialog appears:

   ![Terminology Consistency Analysis](image)

2. Select the terminology database to use as reference from the **Terminology Database** drop-down list.

   The following dialog appears:
3. Select an error entry from the list.
4. Click the Go To button to open the segment with terminology errors.
5. Correct the terms in target text.
6. Click the Refresh button to review the file and update the list of errors.
7. Repeat previous steps until all errors are fixed.

**Leading/Trailing Spaces Analysis**

**Procedure**

1. In QA menu, select Leading/Trailing Spaces Analysis or click the button.
   
   The following dialog appears:

   ![Leading/Trailing Spaces Analysis](image)

2. Select an error entry from the list.
3. Click the Go To button to open the segment with space errors.
4. Correct initial or trailing spaces in the segment.
5. Click the Refresh button to review the file and update the list of errors.
6. Repeat previous steps until all errors are fixed.
Spell Check Segment

Procedure

1. In QA menu, select Spell Check Segment or click the button.

2. If there is a spelling error in current target text, the following dialog appears:

   ![Spell Checker dialog](image)

   3. If the right spelling for the word displayed in the Unknown Word box appears in the Suggestions list, select it.

   4. If the correct spelling is not included in the Suggestions list, type it in the Replace with text box.

   5. Use the buttons on the right side to indicate the desired action.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Replace</td>
<td>Click the Replace button to replace the text once.</td>
</tr>
<tr>
<td>Replace All</td>
<td>Click the Replace All button to replace all appearances of the unknown word in one go.</td>
</tr>
<tr>
<td>Ignore</td>
<td>Click the Ignore button to ignore the unknown word once.</td>
</tr>
<tr>
<td>Ignore All</td>
<td>Click the Ignore All button to ignore all instances of the unknown word.</td>
</tr>
<tr>
<td>Add Word</td>
<td>Click the Add Word button to add the unknown word to the internal list of exceptions.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Click the Cancel button to stop the spell checker and ignore the rest of the segment.</td>
</tr>
</tbody>
</table>

6. Repeat the previous steps until all errors are fixed and the dialog is dismissed.

Spell Check Document

About this task

Swordfish lets you check the spelling of an XLIFF file iterating over all segments.

Procedure

1. In QA menu, select Spell Check Document or click the button.

2. If there is a spelling error in the document, the following dialog appears:
3. If the right spelling for the word displayed in the **Unknown Word** box appears in the **Suggestions** list, select it.

4. If the correct spelling is not included in the **Suggestions** list, type it in the **Replace with** text box.

5. Use the buttons on the right side to indicate the desired action.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Replace</td>
<td>Click the <strong>Replace</strong> button to replace the text once.</td>
</tr>
<tr>
<td>Replace All</td>
<td>Click the <strong>Replace All</strong> button to replace all appearances of the unknown word in one go.</td>
</tr>
<tr>
<td>Ignore</td>
<td>Click the <strong>Ignore</strong> button to ignore the unknown word once.</td>
</tr>
<tr>
<td>Ignore All</td>
<td>Click the <strong>Ignore All</strong> button to ignore all instances of the unknown word.</td>
</tr>
<tr>
<td>Add Word</td>
<td>Click the <strong>Add Word</strong> button to add the unknown word to the internal list of exceptions.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Click the <strong>Cancel</strong> button to stop the spell checker and ignore the rest of the document.</td>
</tr>
</tbody>
</table>

6. Repeat the previous steps until all errors are fixed and the dialog is dismissed.
TTX Exchange

TTX Exchange Workflow
The TTX Exchange mechanism included in Swordfish lets you collaborate with translators equipped with translation tools that don’t support XLIFF files but support the TTX format.

The intended TTX Exchange workflow is as follows:

1. An XLIFF file is created from a set of source documents;
2. A TTX file is created from the XLIFF file generated in previous step;
3. The TTX file is translated using Trados TagEditor or a compatible tool;
4. Translations from the TTX file are imported into the original XLIFF document;
5. The XLIFF file is reviewed and translations are marked as approved;
6. A set of translated documents is generated by converting the XLIFF file to original format.

Only XLIFF files generated by Swordfish can be exported as TTX. Accordingly, translations can only be imported from TTX files generated by Swordfish.

Export XLIFF File as TTX

Procedure

1. In File menu, select Open File or click the button.
2. Locate and open the XLIFF file to be exported.
3. In the File menu, select TTX Exchange.
4. In the TTX Exchange sub-menu, select Export File as TTX.
5. Select a file name and location for storing the generated TTX file.

Results
A TTX file is created from the selected XLIFF file.

Import Translations from TTX

Procedure

1. In File menu, select Open File or click the button.
2. Locate and open the XLIFF file to be updated with translations from a TTX file.
3. In the File menu, select TTX Exchange.
4. In the TTX Exchange sub-menu, select Import Translations from TTX.
5. Locate and open the TTX file that contains the translations to be imported.

Results
The number of imported translations is displayed in a confirmation dialog.
Machine Translation

Machine Translation Engines

Swordfish supports three MT (Machine Translation) engines:

- Google's Machine Translation engine
- Microsoft's Bing Translator
- Yandex.Translate

Using Machine Translation is a two-step process:

2. Request the translation of individual segments or the complete file at translation time.

Obtaining Google API Key

You need a personal code, known as "API Key" for using Google's Machine Translation Engine. You can get your personal API Key at Google's API Console.

Obtaining Microsoft Credentials

Obtaining the required credentials for using Microsoft's Bing Translator is a two step process:

1. **Subscribe to the Microsoft Translator API on Azure Marketplace**
   
   Subscribe to the Microsoft Translator API on Azure Marketplace. Basic subscriptions, up to 2 million characters a month, are free. Translating more than 2 million characters per month requires a payment. You may pick from any of the available subscription offers.

2. **Register your application with Azure DataMarket**

   To register your application with Azure DataMarket, visit https://datamarket.azure.com/developer/applications/ using the LiveID credentials from step 1, and click on “Register”. In the “Register your application” dialog box, you can define your own Client ID and Name. The redirect URI is not used for the Microsoft Translator API. However, the redirect URI field is a mandatory field, and you must provide a URI to obtain the access code. A description is optional. Take a note of the client ID and the client secret value.

Obtaining an API key for Yandex.Translate


Yandex.Translate supports the following languages:

- Russian
- English
- Polish
- Ukrainian
- German
- French
- Belarusian
Configure Machine Translation Engines

Procedure

1. In Options menu, select Machine Translation Engines.

   The following dialog appears:

2. If you want to use Google's Machine translation engine:
   a. Check the Enable Engine check box in the Google Machine Translation section.
   b. Select the source language in the Source Language drop-down list.
   c. Select the target language in the Target Language drop-down list.
   d. Enter your API Key for version 2 of Google's Machine Translation Engine in the V2 API Key text box.

3. If you want to use Bing Translator engine:
   a. Check the Enable Engine check box in the Bing Translator section.
   b. Select the source language in the Source Language drop-down list.
c. Select the target language in the **Target Language** drop-down list.
d. Enter your Client ID in the **Client ID** text box.
e. Enter your secret phrase in the **Secret Phrase** text box.

4. If you want to use Yandex.Translate engine:
   a. Check the **Enable Engine** check box in the Yandex.Translate section.
b. Select the source language in the **Source Language** drop-down list.
c. Select the target language in the **Target Language** drop-down list.
d. Enter your API Key for version 1.5 of Yandex.Translate in the **API Key** text box.

5. Click the **Save Configuration** button.

---

## Translate Segment with MT

### Before you begin

Machine Translation Engines configuration must be completed before requesting MT translations.

### Procedure

1. In the **Tasks** menu, select **Translate Current Segment Using MT** or click the button.

### Results

A translation request is sent to the enabled Machine Translation engines. Replies are displayed in the **TM Matches** panel.
XSL Transformation

Applying XSL Transformations

You can transform an XML document to a different format by applying an XSL transformation.

Procedure

1. In Tasks menu, select XSL Transformation.

   The following dialog appears:

2. Type the name of the document to be transformed in the Source File text box or use the Browse... button next to it for selecting an existing document from the file system.

3. Type the name of the XSL Stylesheet to apply in the XSL Stylesheet text box or use the Browse... button next to it for selecting the stylesheet from the file system.

4. Type the name of the document to generate with the transformation process in the Transformed File text box or use the Browse... button next to it to specify the name and location of the resulting file.

5. Check the Open Transformed File on Completion box if you want to open the transformed file in the default viewer after the transformation is finished. Leave this check box empty otherwise.

6. Click the Transform button.

Results

The selected XSL stylesheet is applied to the source XML document and the result of the transformation is stored in the indicated file. Transformation results are displayed in the default viewer configured in the operating system if the corresponding check box is selected.
Configuration Options

User Interface

Font Settings

Procedure
1. In the Preferences dialog, select the Basic tab.
2. Select the Change Default Font button.
3. In Options menu, select User Interface Configuration.
4. In the User Interface Configuration sub-menu, select Font Settings.
5. In the font selection dialog, choose the default font, font style and font size to be used by the application.

Results
Selected font will be used by the application to display text in relevant places.

Shortcuts Configuration

Procedure
1. In Options menu, select User Interface Configuration.
2. In the User Interface Configuration sub-menu, select Shortcuts Configuration.
   
   The following dialog appears:

   ![Keyboard Shortcuts Dialog]

3. Use the scroll bar on the right side to locate the command that you want to modify.
4. Check the boxes for the modifier keys (Alt, Ctrl, Cmd or Shift) required in the new or modified shortcut.
5. Type a character or select a standard key in the drop-down-list on the right.
6. Repeat the previous 3 steps until all keyboard shortcuts have been configured as desired.
7. Click the Save button to save your changes or click the Load Defaults button to restore factory settings and restart the configuration task.
Results
The requested changes are stored in the configuration file and become effective the next time the program is started.

Color Settings

Procedure

1. In Options menu, select User Interface Configuration.

2. In the User Interface Configuration sub-menu, select Color Settings.

   The following dialog appears:

   ![Default Colors dialog](image)

3. Locate the element that you want to modify and enter the RGB values for the desired color in the text box or click the Select... button to choose a new color using the default color selector widget from the operating system.

4. Repeat previous step until all colors have been adjusted.

5. Click the Save Colors button to save your changes.

XML Filter Configuration

The program needs to know two things for working with XML files:

- How to locate the grammar rules and entities declared in an XML file, if any.
- What elements and attributes contain translatable text.
XML catalogs that follow the specification published at http://www.oasis-open.org/committees/entity/spec-2001-08-06.html by OASIS are used to resolve the location of XML DTDs and Schemas.

Special XML files are used to configure the elements and attributes that contain translatable text. These files are used by the internal XML Converter to extract text for processing. The configuration files are created and maintained using the application’s graphical user interface.

In the Preferences dialog, select the XML Options tab. The dialog will look like this:

![Preferences dialog](image)

**XML Catalog**

The application includes a default XML catalog with DTDs and XML Schemas for the most relevant localization formats and supported document types.

Additional DTDs and XML Schemas can be added by the user as needed.

**Add Catalog Entry**

**Procedure**

1. In Options menu, select Catalog Manager.

   The following dialog appears:
2. In the **Preferences** dialog, select the **XML Options** tab.

3. Click the **Add Catalog Entry** button.

   The following dialog appears:

4. Select the appropriate entry type from the list.

5. Click the **Set Entry Type** button.

6. If the type of the new entry is "PUBLIC", the following dialog appears:

   a. Type the public id of the DTD in the **Public ID** text box.
   b. Type the location of the DTD, relative to the catalog, in the **URI** text box.
   c. Click the **Save Entry** button.

7. If type of the new entry is "SYSTEM", the following dialog appears:
a. Type the name of the DTD or XML Schema in the **System ID** text box.
b. Type the location of the DTD or XML Schema, relative to the catalog, in the **URI** text box.
c. Click the **Save Entry** button.

8. If type of the new entry is "URI", the following dialog appears:

   a. Type the name of the URI in the **URI Name** text box.
   b. Type the location of the corresponding DTD or XML Schema, relative to the catalog, in the **URI** text box.
   c. Click the **Save Entry** button.

9. If the type of the new entry is "nextCatalog" a file selection dialog appears. Locate the catalog in the file system and save it.

**Edit Catalog Entry**

**Procedure**

1. In **Options** menu, select **Catalog Manager**.

   The following dialog appears:
2. In the **Preferences** dialog, select the **XML Options** tab.

3. Select the entry to modify from the entry list.

4. Click the **Configure Catalog Entry** button.
   
   A dialog of the appropriate type for editing the selected entry appears.

5. Edit the properties of the entry.

6. Click the **Save Entry** button to close the properties configuration dialog.

### Delete Catalog Entry

**Procedure**

1. In **Options** menu, select **Catalog Manager**.

   The following dialog appears:

   ![Catalog Manager Dialog](dialog.png)

2. In the **Preferences** dialog, select the **XML Options** tab.

3. Select the entry to remove from the entries table.

4. Click the **Remove Catalog Entry** button.
   
   A confirmation dialog appears.

5. Confirm the delete operation.

### Results

The selected entry is removed from the XML catalog.

### XML Converter

Support for the following XML vocabularies is included in the application:

- DITA 1.0, 1.1 and 1.2
- DocBook 3.x, 4.x and 5.x
- Microsoft Visio 2010 and 2013
- Open Document Format (OpenOffice)
Additional configurations can be added by the user as required.

**Add XML Configuration**

**Procedure**

1. In **Options** menu, select **XML Converter Configuration**.

   The following dialog appears:

   ![XML Converter Configuration](image)

2. In the **Preferences** dialog, select the **XML Options** tab.

3. Click the **Add Configuration File** button.

   The following dialog appears:

   ![Root Element Configuration](image)

4. Type the name of the root element of your XML files in the **Root Element** text box. The name of the root element is used to name the configuration file.

5. Click the **Set Root Element** button.

   The following dialog appears:
6. Click the **Add Element** button to add the configuration of an element.

The following dialog appears:

7. Type the name of the element being added in the **Element Name** text box.

8. Select the type of element in the **Element Type** drop-down list. Available types are:
   - **segment**: the selected element starts a new section of translatable text.
   - **inline**: the selected element represents a change in formatting options and does not start a new section of translatable text.
   - **ignore**: the selected element and its children should be ignored.

9. If the element type is "inline", select the kind of formatting represented by the element in the **Inline Type** drop-down list.

10. If the element has translatable attributes, enter their names separated by a ";" in the **Translatable Attributes** text box.

11. If white space needs to be preserved when extracting text, select "Yes" in the **Keep White Space** drop-down list.

12. Click the **Save Element** button to save the element configuration.

13. Repeat the previous steps until all required elements have been configured.

**Results**

A new configuration file for the XML Converter is created.
Analyze XML Sample

About this task
A basic configuration file can be generated automatically by the application by analyzing a sample XML document. Follow these steps to create an initial configuration from an existing XML document.

Procedure
1. In Options menu, select XML Converter Configuration.

   The following dialog appears:

   ![XML Converter Configuration dialog](image)

2. In the Preferences dialog, select the XML tab.

3. Click the Analyze XML Sample button.

4. Locate and open the XML file to be analyzed.

   The file is analyzed and the following dialog appears:

   ![DTD Configuration](image)

5. Use the Add Element, Edit Element and Remove Element buttons to make necessary adjustments in the configuration file.

Results
A new configuration file based on the selected XML sample is created.

Edit XML Configuration

Procedure
1. In Options menu, select XML Converter Configuration.
The following dialog appears:

2. In the Preferences dialog, select the XML Options tab.

3. Select the configuration file to edit from the list of available configurations.

4. Click the Edit Configuration File button.

The following dialog appears:

5. Use the buttons in the DTD Configuration dialog to update the configuration file.
   - Use the Add Element button to add a new element to the configuration file.
   - Use the Edit Element button to modify the properties of an existing element.
   - Use the Remove Element button to delete an element from the configuration file.

6. Repeat the previous step until all elements are properly configured.

Delete XML Configuration

Procedure

1. In Options menu, select XML Converter Configuration.

   The following dialog appears:
2. In the **Preferences** dialog, select the **XML Options** tab.

3. Select the entry to remove from the configurations list.

4. Click the **Remove Configuration File** button.

   A confirmation dialog appears.

5. Confirm the delete operation.

**Results**

The selected entry is removed from the list of available configuration files.

**Spell Checker Configuration**

Swordfish includes a built-in spell checker that uses dictionaries in **Hunspell** format.

**Download Dictionaries**

Steps for downloading dictionaries to be used with the built-in spell checker.

**Procedure**

1. In **Options** menu, select **Internal Dictionaries**.

   The following dialog appears:

2. Click the **Download Dictionaries** button.

   The following dialog appears:
3. If your computer uses a proxy server to connect to the Internet, follow these steps to configure the proxy server settings:
   
   a. Click the **Proxy Settings** button.
      
      The following dialog appears:
      
      ![Proxy Settings Dialog]

      b. Type the proxy server name or IP in the **Server** text box.
      
      c. Type the proxy port number in the **Port** text box.
      
      d. If your proxy server requires authentication, type the proxy user name in the **User ID** text box and the corresponding password in the **Password** text box.
      
      e. Click the **save Settings** button.

4. Optionally, click the **Refresh Dictionary List** button to retrieve the latest list of available dictionaries from the download server.

5. Browse the list of available dictionaries and select the one you want to download. Downloaded dictionaries appear with a different background color.

6. Click the **Download Dictionary** button.

7. Repeat the previous two steps until all dictionaries you need have been downloaded.

**Configure Dictionaries**

Steps for associating a downloaded dictionary with a target language.
Procedure

1. In Options menu, select Internal Dictionaries.

   The following dialog appears:

   ![Dictionary Selection Dialog]

   2. Select the language to be associated with a dictionary from the Language drop-down list.

   3. Select the dictionary to be associated with the previously selected language from the Default Dictionary drop-down list.

   4. Click the Add to List button.

   5. Repeat previous steps until all target languages that you need are associated with a dictionary.

   6. Click the Save Dictionaries button.

Results

The selected language is associated with the selected dictionary and the combination is displayed in the list of configured dictionaries.

Automatic QA Checks

Swordfish automatically performs selected quality control checks whenever a segment is approved.

Procedure

1. In Options menu, select Automatic QA Checks.

2. In the Automatic QA Checks sub-menu, select the desired automatic verifications:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spell Check Segment</td>
<td>Verify the spelling of target text using the default dictionary configured for the target language.</td>
</tr>
<tr>
<td>Check Initial/Trailing Spaces</td>
<td>Verify that initial and trailing spaces are the same in source and target text.</td>
</tr>
<tr>
<td>Check Tags</td>
<td>Verify that all inline tags present in source text appear in the target text in the correct order.</td>
</tr>
<tr>
<td>Check Text Length</td>
<td>Verify that the length of target text falls between the minimum and maximum length specified in the XLIFF file.</td>
</tr>
</tbody>
</table>
Language Codes

Standard language codes from BCP47 are used in all operations.

A list of the most common language codes is included in the program. The list of languages can be customized as needed.

In the Preferences dialog, select the Languages tab to configure the languages list. The dialog will look like this:

![Languages List](image)

Add Language

Steps for adding languages to the application

Procedure

1. In Options menu, select Language Codes.

   The following dialog appears:

   ![Language Codes](image)
2. In the Preferences dialog, select the Languages tab.

3. Click the Add Language button.

   The following dialog appears:

   ![Add Language dialog](image)

4. Type the code for the new entry in the Code text box. The code must be a valid language tag from BCP47. Language description is automatically displayed when a valid tag is entered.

5. Click the Add Language button.

**Results**

A new entry is added to the list of working languages.

**Delete Language**

Steps for removing a language from the list of working languages.

**Procedure**

1. In Options menu, select Language Codes.

   The following dialog appears:

   ![Language Codes dialog](image)

2. In the Preferences dialog, select the Languages tab.

3. Select the entry to delete in the list of language codes.

4. Click the Remove Selected Language button.

**Results**

The selected entry is removed from the list of working languages.
Auto-Save Settings

About this task
The program has the ability to automatically make a backup of the file that is open at a selected interval. Follow these steps to configure the automatic backup settings.

Procedure
1. In the Preferences dialog, select the Basic tab.
2. Check the Enable Auto-Save box if you want to make automatic backups. Clear it otherwise.
3. Enter the number of seconds to wait between backups in the Interval (Seconds) text box.
4. Click the Save Settings button.

Plugins
Swordfish is an extensible application. It has a plugin architecture that permits interaction between Swordfish and other tools.

Add Plugin

Procedure
1. In Plugins menu, select Plugin Configuration.
   The following dialog appears:

   The following dialog appears:

2. Click the Add Plugin button.
   The following dialog appears:
3. Type a name for the plugin in the **Plugin Name** text box. Selected name will be used to identify the plugin in the **Plugins** menu.

4. Type the command line to execute for launching the plugin in the **Command Line** text box or click the **Browse...** button to select an application from the file system.

5. Optionally, assign a keyboard shortcut to the plugin.
   a. Check the boxes for the modifier keys (Alt, Ctrl, Cmd or Shift) required in the new shortcut.
   b. Type a character or select a standard key in the drop-down-list on the right.

6. Select the data type that the plugin processes. Available options are:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Segment</td>
<td>The plugin receives as parameter the name of an XML file containing current <code>&lt;trans-unit&gt;</code> element.</td>
</tr>
<tr>
<td>Current Document</td>
<td>The plugin receives as parameter the path to the XLIFF file that is opened in Swordfish.</td>
</tr>
<tr>
<td>Nothing</td>
<td>The plugin does not receive any data from Swordfish.</td>
</tr>
</tbody>
</table>

7. Select the type of result resturned by the plugin. Available options are:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Updated Exchange File</td>
<td>Updated copy of current <code>&lt;trans-unit&gt;</code> element in an XML file. Swordfish replaces current <code>&lt;trans-unit&gt;</code> element with the content of the selected exchange file.</td>
</tr>
<tr>
<td>Updated Document</td>
<td>Swordfish reloads current open XLIFF document.</td>
</tr>
<tr>
<td>Nothing</td>
<td>The plugin does not return any data to Swordfish.</td>
</tr>
</tbody>
</table>
8. If the plugin receives current segment and returns an updated version, indicate the name of the temporary file used for exchanging data in the Exchange File text box or use the Browse... button next to it to select a file from the file system.

9. Click the Save Configuration button.

**Edit Plugin**

**Procedure**

1. In Plugins menu, select Plugin Configuration.

   The following dialog appears:

   ![Plugin Configuration Dialog](image)

2. Select the plugin to edit in the plugins list.

3. Click the Edit Plugin button.

   The following dialog appears:

   ![Edit Plugin Dialog](image)

4. Edit plugins properties as needed.

5. Click the Save Configuration button.
Delete Plugin

Procedure

1. In the Plugins menu, select Plugin Configuration.

   The following dialog appears:

   2. Select the plugin to delete in the plugins list.

   3. Click the Remove Plugin button.

   4. Click the Close button.
# Command Line Interface

## Command Line Parameters

Swordfish accepts two types of parameters on the command line:

- A path to an XLIFF file that is to be opened for translating.
- Commands that perform the following tasks without displaying Swordfish's user interface:
  1. Convert one or more files to XLIFF format;
  2. Convert one XLIFF file to original format;
  3. Apply TM to an XLIFF file;
  4. Apply Machine Translation (MT) to an XLIFF file;
  5. Generate translation status statistics;
  6. Register or disable a License Key.

When Swordfish is installed by "root" on Linux systems, the command "swordfish" is added to the system path and it can be used in a terminal window for processing command line arguments.

On Mac OS X, a shell script is used for executing Swordfish without the graphical user interface. The default location for the script is:

```bash
/Applications/Swordfish_III/swordfish.sh
```

On Windows it is possible to use two different launchers:

- **Swordfish.exe** runs Swordfish as a background process and only Windows Task Manager can provide indications of activity.
- **swordfish.bat** runs in the currently open console and it is easier to tell when the program has finished or if there were errors during the process.

## Convert Files to XLIFF Format

Swordfish lets you convert a single document to XLIFF format if you pass all the required parameters individually. You can also convert one or more documents to XLIFF using *project* files.

A project file is an XML document that contains this information:

- The name of the XLIFF file to generate;
- the SRX file to use during segmentation;
- the source language;
- the target language;
- the list of files to convert, indicating:
  1. document type
  2. character set of the document

The following example shows a basic project for generating an XLIFF file from two documents:
A DTD (xliffProject.dtd) and an XML Schema (xliffProject.xsd) that define the grammar used for building projects are included in Swordfish’s default XML catalog.

A project file can be created using any XML editor or using Swordfish’s conversion dialog. See Create a Project File Using Swordfish for details.

**Convert One Document to XLIFF Format**

The following parameters, followed by the appropriate values, are passed to Swordfish for converting one document to XLIFF format:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-c</td>
<td>source_file</td>
<td>The full path to the file that needs to be converted.</td>
</tr>
<tr>
<td>-x</td>
<td>xliff_file</td>
<td>The full path to the XLIFF file to be generated.</td>
</tr>
<tr>
<td>-s</td>
<td>source_language</td>
<td>The ISO code of the source language.</td>
</tr>
<tr>
<td>-t</td>
<td>target_language</td>
<td>The ISO code of the target language.</td>
</tr>
<tr>
<td>-f</td>
<td>document_format</td>
<td>The constant that defines the document type. See File Types table.</td>
</tr>
<tr>
<td>-cs</td>
<td>charset</td>
<td>The character set of the source file.</td>
</tr>
<tr>
<td>-sr</td>
<td>srx_file</td>
<td>The full path to the SRX file used for segmenting the source document. This parameter is optional.</td>
</tr>
</tbody>
</table>

Example:

```
swordfish.bat -c c:\sources\Sample.docx -s de -t en -x c:\xliff\Sample.docx.xlf -f OFF -cs UTF-8
```

**Convert Multiple Documents to XLIFF Format**

The following parameters, followed by the appropriate values, are passed to Swordfish for converting a project to XLIFF format:
The full path to the XML file that defines the project data.

Example:

```
swordfish.bat -c c:\projects\SampleProject.spr
```

Create a Project File Using Swordfish

About this task

You can use Swordfish to create a conversion project for generating XLIFF files using the command line.

Procedure

1. In File menu, select Convert Files to XLIFF Format or click the button.

   The following dialog appears:

2. Add all files that need translation using the buttons that appear below the files list.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Files</td>
<td>Display a file selection dialog for selecting one or more files from the file system.</td>
</tr>
<tr>
<td>Add Directory</td>
<td>Display a dialog for selecting a directory from the file system. All its files and sub-directories are added to the list.</td>
</tr>
<tr>
<td>Delete Selected Files</td>
<td>Delete from the list all files that have its check box selected.</td>
</tr>
</tbody>
</table>

3. Use the drop-down lists next to each file to select or correct the file type and character set of the document.
4. Type a name for the XLIFF file to generate in the **XLIFF File** text box or use the **Browse...** button to select a file name and location.

5. Select the source language of the XLIFF file using the **Source Language** drop-down list.

6. Select the target language of the XLIFF file using the **Target Language** drop-down list.

7. Click the **Save Project** button.

8. Select a file name and location for storing the generated project file.

**Results**

A project file is created, containing the information required to convert the selected documents to XLIFF format.

**File Types**

Constants used to indicate the type of a document when converting to XLIFF format.

<table>
<thead>
<tr>
<th>Type</th>
<th>Document Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>INX</td>
<td>Adobe InDesign Interchange</td>
</tr>
<tr>
<td>IDML</td>
<td>Adobe InDesign IDML</td>
</tr>
<tr>
<td>DITA</td>
<td>DITA Map</td>
</tr>
<tr>
<td>HTML</td>
<td>HTML Page</td>
</tr>
<tr>
<td>JS</td>
<td>JavaScript</td>
</tr>
<tr>
<td>JAVA</td>
<td>Java Properties</td>
</tr>
<tr>
<td>MIF</td>
<td>MIF (Maker Interchange Format)</td>
</tr>
<tr>
<td>OFF</td>
<td>Microsoft Office 2007 Document</td>
</tr>
<tr>
<td>OO</td>
<td>OpenOffice Document</td>
</tr>
<tr>
<td>TEXT</td>
<td>Plain Text</td>
</tr>
<tr>
<td>PO</td>
<td>PO (Portable Objects)</td>
</tr>
<tr>
<td>RC</td>
<td>RC (Windows C/C++ Resources)</td>
</tr>
<tr>
<td>RESX</td>
<td>ResX (Windows .NET Resources)</td>
</tr>
<tr>
<td>RTF</td>
<td>RTF (Rich Text Format)</td>
</tr>
<tr>
<td>SDLXLIFF</td>
<td>SDLXLIFF Document</td>
</tr>
<tr>
<td>TRTF</td>
<td>Tagged RTF</td>
</tr>
<tr>
<td>TS</td>
<td>TS (Qt Linguist translation source)</td>
</tr>
<tr>
<td>TTX</td>
<td>TTX Document</td>
</tr>
<tr>
<td>TXML</td>
<td>TXML Document</td>
</tr>
<tr>
<td>XML</td>
<td>XML Document</td>
</tr>
<tr>
<td>XMLG</td>
<td>XML (Generic)</td>
</tr>
</tbody>
</table>
Swordfish Projects DTD

The following DTD defines the grammar used in Swordfish projects files.

```xml
<!ELEMENT xliffProject (xliff,srx,files)>  
<!ATTLIST xliffProject  
  version CDATA #IMPLIED>  
>

<!ELEMENT xliff (#PCDATA)>  
<!ATTLIST xliff  
  srcLanguage CDATA #REQUIRED  
  tgtLanguage CDATA #REQUIRED>  
>

<!ELEMENT srx (#PCDATA)>  

<!ELEMENT files (file)+>  

<!ELEMENT file (#PCDATA)>  
<!ATTLIST file  
  type (INX|IDML|DITA|HTML|JS|JAVA|MIF|OFF|OO|TEXT|PO|RC|RESX|RTF|SDLXLIFF|TRTF|TS|TTX|TXML|XML|XMLG) #REQUIRED  
  charset CDATA #REQUIRED>
```

The DTD and an XML Schema version of it are available in Swordfish's default XML catalog.

**Convert XLIFF File to Original Format**

The following parameters, followed by the appropriate values, are passed to Swordfish for converting an XLIFF document to original format:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-r</code></td>
<td>xlfiff_file</td>
<td>The full path to the XLIFF file that needs to be converted.</td>
</tr>
<tr>
<td><code>-o</code></td>
<td>output_folder</td>
<td>The full path to the folder where originals will be stored if the XLIFF file contains multiple documents or the name of the translated file if it contains a single document.</td>
</tr>
</tbody>
</table>

Examples:

```
swordfish.bat -r c:\xliff\Sample.docx.xlf -o c:\translated\Sample.docx
```
Leverage In-Context Exact (ICE) Matches

The following parameters, followed by the appropriate values, are passed to Swordfish for leveraging In-Context Exact (ICE) matches from a previously translated XLIFF document:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-ice</td>
<td>xliff_file</td>
<td>The full path to the XLIFF file to be populated with ICE matches.</td>
</tr>
<tr>
<td>-prev</td>
<td>previous_xliff</td>
<td>The full path to the XLIFF file containing previous translations.</td>
</tr>
</tbody>
</table>

Example:

```
swordfish.bat -ice c:\xliff\UpdatedSample.docx.xlf -prev c:\xliff\Sample.docx.xlf
```

Pre-translate an XLIFF File

The following parameters, followed by the appropriate values, are passed to Swordfish for applying TM to an XLIFF document:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-tm</td>
<td>xliff_file</td>
<td>The full path to the XLIFF file to be pretranslated.</td>
</tr>
<tr>
<td>-db</td>
<td>database_list</td>
<td>The list of TM databases to use. To indicate multiple databases, concatenate the names using &quot;</td>
</tr>
</tbody>
</table>

Example:

```
swordfish.bat -tm c:\xliff\Sample.docx.xlf -db mainTM|userTM
```

The following parameters, followed by the appropriate values, are passed to Swordfish for applying Machine Translation to an XLIFF document:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-mt</td>
<td>xliff_file</td>
<td>The full path to the XLIFF file to be pretranslated using the configured MT engines.</td>
</tr>
</tbody>
</table>

Example:
Mark Repeated Segments as Untranslatable/Translatable

The following parameters, followed by the appropriate values, are passed to Swordfish for marking all repeated segments from an XLIFF document as untranslatable:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-lock</td>
<td>xliff_file</td>
<td>The full path to the XLIFF file that contains repeated segments to be locked.</td>
</tr>
</tbody>
</table>

Example:

```
swordfish.bat -lock c:\xliff\Sample.docx.xlf
```

Mark All Segments as Translatable

The following parameters, followed by the appropriate values, are passed to Swordfish for marking all segments from an XLIFF document as translatable:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-unlock</td>
<td>xliff_file</td>
<td>The full path to the XLIFF file that contains repeated segments to be unlocked.</td>
</tr>
</tbody>
</table>

Example:

```
swordfish.bat -unlock c:\xliff\Sample.docx.xlf
```

Export XLIFF file as TMX

The following parameters, followed by the appropriate values, are passed to Swordfish for exporting all approved segments of an XLIFF file as TMX:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-ex</td>
<td>xliff_file</td>
<td>The full path to the XLIFF file to be exported.</td>
</tr>
<tr>
<td>-tmx</td>
<td>tmx_file</td>
<td>The full path to the TMX file to be created.</td>
</tr>
</tbody>
</table>

Example:

```
swordfish.bat -ex c:\xliff\Sample.docx.xlf -tmx c:\xliff\exported.tmx
```
## Import TMX File

The following parameters, followed by the appropriate values, are passed to Swordfish for exporting all approved segments of an XLIFF file as TMX:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-itmx</td>
<td>tmx_file</td>
<td>The full path to the TMX file to be imported.</td>
</tr>
<tr>
<td>-db</td>
<td>database_name</td>
<td>The name of the database in which the TMX file will be imported.</td>
</tr>
<tr>
<td>-cu</td>
<td>customer_name</td>
<td>Optional: name of the customer</td>
</tr>
<tr>
<td>-su</td>
<td>subject</td>
<td>Optional: subject of the TM data</td>
</tr>
<tr>
<td>-pr</td>
<td>project_name</td>
<td>Optional: name of the project related to the TM data</td>
</tr>
</tbody>
</table>

Example:

```
swordfish.bat -itmx c:\TM\memdata.tmx -db my_memory -cu "square 1" -su geometry
```

## Translation Status Analysis

Use the following parameters to generate a Translation Status Analysis log from an XLIFF file:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-tsa</td>
<td>xliff_file</td>
<td>The full path to the XLIFF file to be analyzed.</td>
</tr>
</tbody>
</table>

The generated analysis is stored in the folder where the XLIFF file is located. The name of the log file is the name of the XLIFF file plus ".log.html".

Example:

```
swordfish.bat -tsa c:\xliff\Sample.docx.xlf
```

## Translation Status History

Use the following parameters to add current translation status to the translation status history of an XLIFF file and generate a history report:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-tsh</td>
<td>xliff_file</td>
<td>The full path to the XLIFF file to be analyzed.</td>
</tr>
<tr>
<td>-td</td>
<td>description</td>
<td>Short text that describes the status record being added.</td>
</tr>
</tbody>
</table>
A translation status history report is generated and stored in the folder where the XLIFF file is located. The name of the report file is the name of the XLIFF file plus ".status.html".

Example:

```
swordfish.bat -tsh c:\xliff\Sample.docx.xlf -td "Initial Status"
```

## License Management

Use the following parameters to register a License Key from command line:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-reg</td>
<td>key</td>
<td>The License Key to be registered.</td>
</tr>
</tbody>
</table>

Example:

```
swordfish.bat -reg HAL9000
```

Use the following parameter to disable a License Key from command line:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-dis</td>
<td>key</td>
<td>The License Key to be disabled.</td>
</tr>
</tbody>
</table>

Example:

```
swordfish.bat -dis HAL9000
```

### Note

- Registering or disabling a License Key requires an Internet connection.
- Registration data is sent to the server using TCP/IP protocol on port 9080. Open this port on your firewall during registration or the operation will fail.
- Always disable your license key before reformatting your hard disk or changing operating system.
Glossary

Computer Aided Translation (CAT)
Computer technology application designed to assist human translators in the translation process.

Character Set
A character set (sometimes referred to as code page) is a collection of characters that are associated with a sequence of natural numbers in order to facilitate the storage of text in computers and the transmission of text through telecommunication networks.

Glossary Markup Language (GlossML) is an XML vocabulary specifically designed for containing glossaries used in translation/localization industry.

Localization Service Provider (LSP)
A company or individual specialized in providing translation and localization services.

Machine Translation
A technology that automatically translates text from one language to another using previously defined grammar rules, glossaries, statistic analysis and other methods.

OASIS
OASIS (Organization for the Advancement of Structured Information Standards) is a not-for-profit consortium that drives the development, convergence and adoption of open standards for the global information society.

Regular Expression
Formula or expression that describes text strings using a specially defined syntax.

Source Language
The language of a document that is to be translated.

Segmentation Rules eXchange (SRX) is an XML-based open standard, published by LISA (Localization Industry Standards Association), for describing how translation and other language-processing tools segment text for processing.

Target Language
The language into which a document is being translated.

TBX
TBX (TermBase eXchange) is the open, XML-based standard for exchanging structured terminological data. First released by LISA in May, 2002, TBX was submitted to the International Organization for Standardization (ISO) on February 21, 2007, for adoption as an ISO standard.

Translation Memory eXchange (TMX) is an open standard originally published by LISA (Localization Industry Standards Association). The purpose of TMX is to allow easier exchange of translation memory data between tools and/or translation vendors with little or no loss of critical data during the process.

Translation Memory
Translation Memory (TM) is a language technology that enables the translation of segments (paragraphs, sentences or phrases) of documents by searching for similar segments in a database and suggesting matches that are found in the databases as possible translations.

XLIFF
XLIFF (XML Localization Interchange File Format) is an open standard developed by OASIS (Organization for the Advancement of Structured Information Standards). The purpose of this vocabulary
is to store localizable data and carry it from one step of the localization process to the other, while allowing interoperability between tools.